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    

1. Combination Scale Factor 
a. The CSF will be neglected for transverse measurements. 
b. All bridge span lengths and stations in Infaworks will be grid dimensions. 
c. All Inventor items will be built using ground dimensions. 
d. Additional notes required to denote what is grid and what is ground 

i. May need dual models for some scenarios when girders need to be in ground 
dimensions 

2. Dimensions and Notes 
a. All dimensions and notes will be placed in “Paper Space” at a 1:1 scale. 
b. Standard details will be placed in “Paper Space” at the correct scale. 

i. If detail needs modification place in Model Space at 1:1 scale and modify 
accordingly and place on sheet the same as any other detail. 

c. Borings placed on Revit sheet at 1” = 20’-0”. 
3. Microstation to ACAD line weights 

a. MS 0 = ACAD 0.09 
b. MS 1 = ACAD 0.18 
c. MS 2 = ACAD 0.25 
d. MS 3 = ACAD 0.30 

4. Greyscale Colors 
a. 250 – 255 

i. These will plot as their respective shades of grey 
5. Sheet Size 

a. All Autodesk sheets will be 11x17 (Autocad & Revit). 
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PROJECT FILES 

ACAD_Template.dwt     S:\Bridge_CADD\Autodesk\Civil_3D\Templates 

• Autodesk Drawings (Rehab) 
• Details for Revit Import 

 

ACAD_DeckGrid_Template.dwt    S:\Bridge_CADD\Autodesk\Civil_3D\Templates 

• Autodesk Drawings (Deck Grids) 

 

Sheet Set Template.dst     S:\Bridge_CADD\Autodesk\Civil_3D\Templates 

• Sheet Sets for Autocad Drawings (Rehab) 

 

Deck Grids Sheet Set Template.dst   S:\Bridge_CADD\Autodesk\Civil_3D\Templates 

• Sheet Sets for Autocad Drawings (Deck Grids) 

 

Bridge_071522.rte     S:\Bridge_CADD\Autodesk\Revit\Templates 

• Revit Projects 

 

Bridge_Details_090821.rvt    S:\Bridge_CADD\Autodesk\Revit\Templates 

• Revit Standard Bridge Details for import into project 

 

Bridge_Project_070722.rvt    S:\Bridge_CADD\Autodesk\Revit\Templates 

• Revit Project created from template 

 

Bridge_Tables_092021.rvt    S:\Bridge_CADD\Autodesk\Revit\Templates 

• Revit Tables for import into project 

 

STANDARD DRAWINGS 

• PDF: BR_ Std_Dwg_Binder   S:\Bridge_CADD\StdDwg\PDF 
• CAD:  BR_Std_Dwg.dwg   S:\Bridge_CADD\StdDwg\CAD 
• Sheet Set: BR_Std_Dwg_Set   S:\Bridge_CADD\StdDwg\CAD 
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    

The following guide is for placing Autodesk Bridge Models and Design Files on BIM360 & PCMS. 

 

 

INVENTOR 

1. Place Inventor files on PCMS 
a. Create at a file folder in the DGN folder 

i. Filename: XXXX000BRIVT001 
1. This should also be the name of the full model assembly in Inventor 

b. Place all Inventor parts and assemblies in the above folder 
i. Subfolders may be used to organize parts as needed 
ii. 3D Model Filename: XXXX000BRIVT001.IAM 
iii. See “REVIT” for filenaming of Inventor exports 

c. Create a zip file of this folder 
i. Zip file filename should match the folder filename 

d. Place the above zip file on PCMS 

 

INFRAWORKS 
1. Place Infraworks file on BIM 360 

a. Sync the file to the Project Infraworks folder on BIM360 
i. Filename: XXXX000BRMAP001 

 

REVIT 
1. Place Revit file on PCMS 

a. Create a file folder in the DGN folder 
i. Filename: XXXX000BRRVT001 

1. This should also be the name of the base Revit file 
b. Place all Revit exports from Inventor in this folder 

i. Export Base file of concrete parts 
1. Filename: XXXX000BRRVT001.RVT 

ii. Export all other files as needed 
1. Filename: XXXX000BRRVT001-XXXX.RVT 

a. Suffix the additional parts filename with a description of what the 
export is (ex. -beams, -piles, rails, …..) 

c. Create a zip file of this folder 
i. Zip file filename should match the folder filename 

d. Place the above zip file on PCMS 
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CIVIL 3D 
1. Place Civil 3D files on BIM360 

a. Terrain Filename: XXXX000BRETR001.DWG 
b. Alignment Filename: XXXX000BRALN001.DWG 
c. Borings Filename: XXXX000BRCOR001.DWG 
d. 3D Bridge Filename: XXXX000BRGEN001.DWG 

i. This file will contain the Revit export for Road Design Plans 
e. Map File Filename: XXXX000BRMAP001.DWG (Contains XREF of the above files) 

i. The Map file is only needed if required by design. 

 

AUTOCAD 

1. NEW BRIDGE PROJECT 
a. Place Autocad file on BIM360 

i. 3D Model Filename: XXXX000BRXXX001.DWG (File class to be named per the 
object ex. BNT, PRD, RDE) 

b. Place Civil 3D export to Autocad on BIM360 
i. Terrain Filename: ACAD-XXXX000BRETR001.DWG 
ii. Alignment Filename: ACAD-XXXX000BRALN001.DWG 
iii. Borings Filename: ACAD-XXXX000BRCOR001.DWG 

2. REHAB PROJECT 
a. Place Autocad file on PCMS 

i. Rehab Filename:  XXXX000BRREH001.DWG (Only one file per Rehab, All sheets 
in this file) 

 

SHEET SET 
1. Place Autocad Sheet Set file on PCMS 

a. Sheet Set Filename: XXXX000BRREH001.DST 
i. The sheet set is only required for Autocad Rehab projects. 

1. The filename should match the Autocad filename. 
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    

The following guide is to create new Sheet Sets in Autocad. 

AUTOCAD 

NEW SHEET SET 

Open the Autocad file that contains your sheets 

• Open the Sheet Set Manager 
o Location: View tab 

Palettes palette 

 

 

 

 

• In the Sheet set manager select New Sheet Set 

 

 

 

 

 

 

 

 

• Toggle Example Sheet Set 
• Select Next 
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• Browse to the location of the Sheet 
Set Template 

• Select Next 

 

 

 

 

 

 

• Give the Sheet set a filename 
o This should match the 

filename of the Autocad 
drawing 

• Browse to the location where the file 
will be stored 

o This should be the same 
location as the Autocad 
drawing 

• Select Next 

 

 

• Select Finish 
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ADDING SHEETS 

 

• Right Click on the new sheet set and select “Import Layout as 
Sheet” 

 

 

 

 

 

 

 

 

 

• Browse and select your file that contains the 
sheets 

• Select the Autocad layouts that you want to 
add to the Sheet set 

• Select Import Checked 

 

 

NOTE: Only sheets that are not part of a sheet set may 
be added. 

 

NOTE: The sheets will now show up in the sheet list by 
the layout name 

 

 

 

 

 

 



 
May 14, 2020 

 

        

SETTING PROJECT INFORMATION 

 

• Right Click on the new sheet set and select properties 

 

 

 

 

 

These Properties will fill in the information that is the same for all sheets in the set 

• Under Project Control Fill in the following 
information 

• Project Number 
o This will be the Construction Number 

• Project Name 
 

 

• Under Sheet Set Custom Properties Fill in the 
following information 

• County 
• PE # 

 

• Select OK 

 

 

 

 

 

 

 

 

 



 
May 14, 2020 

 

        

SETTING SHEET INFORMATION 

 

 

Right Click on a sheet in the set and select properties 

 

 

 

 

 

 

 

These Properties will fill in the information that is the same for all sheets in the set 

• Under Sheet Fill in the following 
information 

• Sheet Title 
o This is what will appear in the 

upper right corner of the title 
block and in the list of drawings 

• Sheet Number 
 

 

• Under Sheet Custom Properties Fill in 
the following information 

• Appropriate Initials and Dates for 
o Checked 
o Designed 
o Drawn 

• STR ID 
• Dwg. No. 

o Leave as “XXXXX” until the 
drawing numbers are assigned 

 

 

• Select OK 



 
May 14, 2020 

 

        

SETTING SHEET NUMBERS AND TITLES 

 

 

Right Click on the first sheet in the list and select Rename & 
Renumber 

 

 

 

 

Fill in the following information 

• Number 
o This is the sheet number 

for the sheet that will 
appear in the title block 

• Sheet Title 
o This is the title of the sheet 

that will appear in the title 
block 

• Layout name 
o Leave this as is 

 

Do NOT check the Rename layout check box at the bottom 

Press Next to proceed to the next sheet in the list 

Press OK when done numbering and naming the sheets 

 

NOTE: These can also be set under the Sheet Properties with the Sheet Title & Sheet Number fields.  See 
“Setting Sheet Information” section of this guide for additional details. 
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PLOTTING 

 

 

 

 

 

 

 

 

 

 

• Plot full sheet set 
o Right click on the sheet set name  

• Plot single sheet 
o Right click on the sheet that needs plotting 

 

• Select Publish 
o Publish using Page Setup Override 

 Select the required plot style for the set 
• MDT_11x17_Color 
• MDT_11x17_Color_PDF 
• MDT_11x17_Greyscale 
• MDT_11x17_Greyscale_PDF 
• MDT_11x17_Monochrome 
• MDT_11x17_Monochrome_PDF 

 

 

 

 

 

 

 



 
May 14, 2020 

 

        

LIST OF DRAWINGS 

 

Right click on the sheet set name and select Insert Sheet List Table 

 

 

 

 

 

 

 

 

 

Change the Title Text from “Sheet 
List Table” to LIST OF DRAWINGS 

 

 

Click Add and a new row will be 
added to the list of columns, this will 
be com the drawing number 

 

 

 

 

Click on the sheet number text of the new row and select “Dwg. No.” from 
the list 

 

Double click the text “Dwg. No.” under the Heading text column and change 
the text to DWG. NO. 
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Make sure the “Dwg. No.” row is selected and click move up to move this row between the “Sheet No.” and 
“Title” rows. 

 

 

 

 

The dialog box should 
match what is shown 
here 

 

 

Click Ok 

 

 

 

Locate a point at which to insert the table 

 

 

Format the table remove the column and row borders and 
set the “Sheet No.” and Dwg. No.” columns to center 
justified.  The column and row borders should show up 
grey it they are turned off 
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The following guide is to create deck grids in Autocad. 

Each structure will get its own deck grid drawing, sheet set and pdf of the deck grids. 

This procedure will require the detailer to only draw the outline of the bridge with the appropriate centerlines 
and annotations.  Make no other modifications to the file or the sheets. 

AUTOCAD 

Create a new Autocad file 

• Template = ACAD_DeckGrid_Template.dwt 
• Filename = MDT Structure ID 
• Save Location =  

Draft the outline of the bridge 

• Draft the bridge such that the following is met 
o Extreme end of bridge is located on the line Y = 0 

 This will be the end of slab or edge of paving notch 
o Left face of rail is located on the line X = 0 
o All Annotations are within the deck grid boundary boxes 

Any object that extends outside of the boundary boxes will not appear on the sheets 

• Annotate the bridge with the following in model space at a 1” = 5’-0” annotation scale. 

Annotating in model space will allow for copying the required annotations from sheet to sheet. 

The annotation scale will be previously set in the Template 

o CL Roadway 
 Each sheet containing the bridge 

o Face of rail (each side) 
 Each sheet containing the bridge 

o End of slab or Edge of Paving Notch 
 Beginning and end of bridge 

• Draft the bridge using the following layers 
o DG_Centerlines 

 All centerlines used for the bridge (CL Roadway, CL Bents) 
o DG_Slab 

 Outline of the bridge 
o DG_Text-Dimensions 

 All annotations 
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SHEET SET 

Create a new Sheet Set, See MDT Guidance Autodesk Sheet Sets for additional information. 

• Template = Deck Grids Sheet Set Template.dst 
• Filename = MDT Structure ID 
• Save Location =  

Fill in the 6 fields in the “Sheet Set Custom Properties” Section Only.  This information will populate the title 
block on all sheets. 

• Bridge Name 
o Use the name listed in SMS 

• MDT STR. ID 
• NBI Number 
• Route 

o Use the route listed in SMS 
• Ref Point 

o Use the Reference Point listed in SMS 
• Number of Sheets 

o This will be the total number of sheets; this is also the number located in the deck grid 
boundary that is on the last sheet containing the bridge 

Add only the sheets containing the bridge to the sheet set 

• Rename and Renumber 
o Will need to fill in the number box in the dialog 

 All other information to remain as is 
 This will number the sheets correctly in the title block 

Plot the sheet set 

Verify ALL levels are turned on and thawed before plotting 

• Publish 
o Publish using Page Setup Override 

 MDT_DeckGrid_11x17_Greyscale_PDF 
• Save the pdf to the same location as the Autocad file and Sheet Set using 

the structure number as the file name 
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The following is a brief synopsis for the Workflow 3.14159265.  Additional information on the topics can be 
found elsewhere in the Autodesk Guidance document. 

FILE MANAGEMENT 

• All Inventor and Revit files will be placed on PCMS for this workflow 
• Place all Inventor files in a folder 

o Filename: XXXX000BRIVT001 
• Place all Revit files in folder 

o Filename: XXXX000BRRVT001 
 This needs to match the file name of the initial export from Inventor 

 

INVENTOR 

EXPORT REVIT FILES 

• Export Concrete Parts 
o These are only the parts that require reinforcing in Revit. 

 Caps, Backwalls, Diaphragms, Slabs. Ect. 
• This file will have the filename that matches the folder created above. 

• Export other parts as required 
o Beams, Riprap, Rails, Joint Fillers, Piles, Ect. 

 Filename: XXXX000BRRVT001-Beams 

 

REVIT 

Open the Revit file XXXX000BRRVT001.RVT containing the bridge model 

IMPORT STANDARDS 

• Open the Bridge_Project from the Template location 
o Transfer project standards from this file to your file 

• Import views from the file 
o Use the Bridge_Project file 

 Copy all available details, tables, and sheets 

FILE SETUP 

• Set View Range in the view titled “Level 1” 
o Set the following (Upon completion of this step you bridge should be visible) 

 Top = Unlimited 
 Cut = An Elevation Above the bridge 
 Bottom = Unlimited 
 Depth = Unlimited 

o Rename this view to “SITE” 
o Turn on all the “Site” Items in Visibility/Graphics 
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• Link Road Alignment into file 
o Set this file to the center of the bridge 

 This file should contain a point at CL Bridge. 
 This file should contain a mark for locating other files 

o Rotate alignment to horizontal 
 This should match the bridge orientation 

• Set True north in the file 
• Set or Verify Project North in the file 
• Set the project coordinates at the CL Bridge 

LINK ADDITIONAL REVIT FILES 

• Link all additional Revit files created from the Inventor exports 

 

LINK TERRAIN 

• Link in the terrain file 
o This is a published surface from Civil 3D 

 User will need to publish this file 
 Large Terrain files will require clipping before publishing 

 

DETAIL BRIDGE 

• Create views and levels as necessary to detail the bridge 
o Some of these items will require set up by the user 

 See RevitSettings.pdf 
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The following is the best practice for Workflow 3.14159265 for building the Inventor model and placing the 
alignment and terrain in Revit.   

 

CIVIL 3D 

• In Civil 3D set proxy graphics = 1 
o This is required to be set for the alignment to go into Revit 

LOCATE POINT ON ALIGNMENT 

• Locate a point on the alignment 
o Point is at CL Bridge at CL Roadway 

 This should match the X,Y,Z point in Inventor 
• Start the point command 

o Type ‘so 
 This is also found on the “Transparent” tab “Station Offset” 

• Select the Alignment 
• Key in the station and press enter 
• Key in the offset and press enter 

o This should be zero 
• You now have a point on the alignment 

 

ANNOTATE ALIGNMENT POINT 

• Annotate the Point 
• From the “Annotate” expand “Add Labels” 

expand “Alignment” Select “Station/Offset – 
Fixed” 

• Select the alignment 
• Select the previously created point 
• This will give you the coordinates for the 

center of your bridge for use in Revit later. 

 

 

ADDITIONAL ITEMS TO CONSIDER 

• Place additional 2D line work items in this file as required for the plan set. 
o Existing Bridge Outline 
o Existing Bridge Substructure 
o Utilities 
o Boring Locations 
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INVENTOR 

MODEL SETUP 

• Orientate the bridge model assembly with the top of the bridge 
on the top view, and ahead on-line along the “X” axis from left to 
right. 

o Individual model parts can be drawn in any axis or 
orientation. 

• Model will contain most if not all elements necessary for the final bridge plans 

 

 

 

 

EXPORT REVIT FILES 

• Export Concrete Parts 
o These are only the parts that require reinforcing in Revit. 

 Caps, Backwalls, Diaphragms, Slabs, ect. 
• This file will have the filename that matches the folder created above. 

• Export all other parts as needed 
o These exports will be of parts that need to be shut off independently of other parts 

 Additionally, these exports should be thought out such that a change to a particular 
component wouldn’t necessarily change other components throughout the entire 
bridge. 
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REVIT 

Open the Revit file XXXX000BRRVT001.RVT containing the concrete bridge parts 

IMPORT STANDARDS 

• Open the Bridge_Project from the Template 
locations 

• Transfer project standards from this file to your 
file 

 

• Import views from the file 
o Use the Bridge_Project file 

 Copy all available details, tables, and 
sheets 

 

 

FILE SETUP 

• Set View Range in the view titled 
“Level 1” 

o Set the following 
 Top = Unlimited 
 Cut = An Elevation 

Above the bridge 
 Bottom = Unlimited 
 Depth = unlimited 

o Rename this view to “SITE” 
o Turn on all the “Site” Items in Visibility/Graphics 

 

 

 

• Set the project coordinates at the CL Bridge 
o These should match the coordinates from the Civil 

3D alignment 
o Choose the point that is the project base point 

• Relocate the Survey Point back to coincident with the Project 
Base Point. 

 

 



 
October 12, 2022 

 

        

• Link Road Alignment into file 
o From the “Insert” tab 

select “Link Cad” 
 This file 

should contain 
a point at CL 
Bridge. 

 

 

• Rotate alignment to horizontal 
o This should match the bridge orientation 
o Rotate the alignment about the Project Base Point 

 

 

 

• Set True north in the file 

 

 

Verify Coordinates are correct after setting 
True North 

 

 

LINK TERRAIN 

• Link in the terrain file 
o This is a published surface from Civil 3D 

 User will need to publish this file 
• Large Terrain files will require clipping before publishing 

• From the “Insert” tab select “Link Topography” 
o Select the file from BIM360 




October 4, 2022 

Revit_Settings.docx 

    

The following are the required settings for the various items in Revit. 

CONTENTS 
GRIDS  LEVELS ELEVATIONS  SECTIONS  DETAIL VIEWS
 CONTOUR LABELS  SPOT ELEVATIONS 

 

GRIDS 
SYSTEM FAMILY: GRID 

  

 

 

 

 

 

 

 

 



 
October 4, 2022 

 

        

LEVELS 
SYSTEM FAMILY: LEVEL 

  



 
October 4, 2022 

 

        

ELEVATIONS 
SYSTEM FAMILY: ELEVATION    GRAPHICS / ELEVATION TAG 
  
   

  

      
  

GRAPHICS / CALLOUT TAG 

 

 

 

 

 

 

 

 

 

 

 

 



 
October 4, 2022 

 

        

SECTIONS 
SYSTEM FAMILY: SECTIONS    GRAPHICS / SECTION TAG 

  

 

 

 

 

 

 

 

 

 

 

 

 

GRAPHICS / CALLOUT TAG 

 See ELEVATIONS for Callout Tag Settings 

 

 

 

 

 

 

 

 

 

 



 
October 4, 2022 

 

        

DETAIL VIEWS 
SYSTEM FAMILY: DETAIL VIEW 

 

GRAPHICS / CALLOUT TAG 

 See ELEVATIONS for Callout Tag Settings 

GRAPHICS / SECTION TAG 

 See SECTIONS for Section Tag Settings 

 

 

 

 

 

 

 

 

 



 
October 4, 2022 

 

        

CONTOUR LABELS 
SYSTEM FAMILY: CONTOUR LABELS      TEXT / UNITS FORMAT 

         

 

 COLOR choice is up to the user 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
October 4, 2022 

 

        

SPOT ELEVATIONS 
SYSTEM FAMILY: SPOT ELEVATIONS    TEXT / UNITS FORMAT 

   

 

 

 COLOR choice is up to the user 




April 23, 2020 

OpenRoads_To_Autodesk.docx 

    

The following guide is to get OpenRoads alignments and terrain into Autodesk for bridge modeling. 

Download the following road design files from DMS 

• XXXX000XXALN001.DGN (OpenRoads Alignment file) 
• XXXX000XXETR001.DGN (OpenRoads Terrain file) 

 

OPEN ROADS 

TERRAIN EXPORT 

Open the XXX000XXETR001.DGN file in OpenRoads 

• Select the terrain boundary line 
• Hover mouse over selected boundary line until 

dialog box pops up 
• Expand the 3rd Option from the left (Export Terrain 

Model) 
• Select LandXML Export 

 

Enter the appropriate values in the Next 3 dialog box popups at the cursor. 

Enter a Project Name  

Left Click to accept 

 

Enter a project description 

(This may be left blank) 

Left Click to accept 

 

Verify “Export Both” is the current value 

Left Click to accept 

 

Save the file to BIM360 in the Civil 3d folder with the following filename 

Filename: XXXX000BRETR001.XML 

 

 



 
April 23, 2020 

 

        

ALIGNMENT EXPORT 

Open the XXX000XXALN001.DGN file in OpenRoads 

• Select the alignment 
• Hover mouse over selected alignment until 

dialog box pops up 
• Expand the 4th Option from the right 

(Horizontal Geometry Report) 

 

 

Select “AlignmentsToLandXML.xsl” from the 
CivilGeometry folder (This should be the first 
option in the list) 

 

 

 

 

 

 

Do a File > Save As 

 

Save the file to BIM360 in the Civil 3D 
folder with the following filename 

New Filename: XXXX000BRALN001.XML 

 

LEAVE THE “Save as type” SET TO 
“Text File (*.txt)” 

 

 

 

 

 



 
April 23, 2020 

 

        

CIVIL 3D 

Create a new file from the Template: C3D_Template.dwt 

Save the new file as: 

• Alignment: XXXX000BRALN001.DWG 
• Terrain: XXXX000BRETR001.DWG 

TERRAIN IMPORT 

Open the XXXX000BRETR001.DWG file 

 

From the “Insert” tab select “LandXML”  

 

Select the XXXX000BRALN001.XML created above from 
BIM360 

 

 

 

 

Verify the Import LandXML dialog box matches 
what is shown here 

 

 

 

 

 

 

 

 

 

 



 
April 23, 2020 

 

        

ALIGNMENT IMPORT 

Open the XXXX000BRALN001.DWG 

From the “Insert” tab select “LandXML” 

 

Select the XXXX000BRALN001.XML created above from 
BIM360 

 

 

 

Verify the Import LandXML dialog box matches what is shown 
here 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
April 23, 2020 

 

        

INFRAWORKS 

Create a new file or open an existing file 

New Filename: XXXX000BRMAP001  (There is no file extension when creating Infraworks files) 

 

The initial model will need its model properties set for the proper coordinate system  

 

Select the “Model Properties” from the “Model” tab 

 

 

 

 

 

 

 

 

Expand the USC box and Select the 
MT83IF coordinate system 

 

If this option is not available 

Select the “Globe” icon and scroll 
down and select the following 

• USA, Montana 
o MT83IF 

 

 

 

 

 

 



 
April 23, 2020 

 

        

TERRAIN IMPORT 

Open the “Data Source” toolbox 

 

 

 

 

 

 

 

Add a data source by “Autodesk Civil 3D DWG” 

 

 

 

 

Select the terrain file XXXX000BRETR001.DWG created in the 
Civil 3D Terrain import section. 

 

 

This data source now needs to be configured. 

 

Double click on the 
newly added data 
source 

Change the 
coordinate system 
to MT83IF 

 

Select Close and Refresh at the bottom of this box when finished 

 

The terrain is now loaded into the model. 



 
April 23, 2020 

 

        

ALIGNMENT IMPORT 

Open the “Data Source” toolbox 

 

 

 

 

 

Add a data source by “Autodesk Civil 3D DWG”  

 

 

 

 

Select the alignment file XXXX000BRMAP001.DWG created in 
the Civil 3D alignment import section. 

 

 

 

 

 

 

 

This data source now needs to be configured. 

Double click on the 
newly added data 
source 

Change the 
coordinate system 
on the “Geolocation” 
tab to MT83IF 

 



 
April 23, 2020 

 

        

 

Click on the style chooser on the 
“Common” tab > Style Section > Assembly 
Style 

 

 

 

 

Browse to the style 

Component/Assembly/Two Lanes and 
press OK 

 

Currently the “Two Lanes” style comes into 
the model as 4 Lanes. Just use the outside 
2 lanes as shoulders or delete them based 
on the needs of the model. 

 

 

 

 

 

Select Close and Refresh at the bottom of this data source configuration when finished 

 

The alignment is now loaded into the model. 




July 1, 2020 

Surface_Clip.docx 

    

The following guide is to clip Open Roads terrain for use in Infraworks, Civil 3D and Revit. 

Download the following file from BIM360 

• XXXX000RDETR001.DGN (Open Roads Terrain file) 

 

OPEN ROADS 

TERRAIN CLIP 

Open the XXXX000RDETR001.DGN file 

Locate a rectangle or closed shape at the boundary of the area to be clipped. 

 

• From Civil Tools / Terrain Model 
o Create Clipped Terrain Model 

• Select the boundary of the existing terrain model 
• Next select the clipping boundary 

o This is the rectangle created earlier 
• Right click to reset 

 

 

Enter the appropriate values in the next 3 boxes 

 

Set Horizontal value = 0 

Left Click to accept 

 

Set Vetical Offset value = 0 

Left Click to accept 

 

Set Clipping Method to “External” 

Left Click to accept 

 

The terrain has now been clipped where the boundary lines intersected the existing terrain.  Use this new 
boundary line for exporting to Infraworks, Civil 3D and Revit. 




October 5, 2022 

Surface_Clip_C3D.docx 

    

The following guide is to clip Civil 3D terrain for use in Infraworks and Revit. 

Download the following file from BIM360 

• XXXX000RDETR001.DWG (Civil 3D Terrain file) 

 

CIVIL 3D 

TERRAIN CLIP 

Open the XXXX000RDETR001.DWG file 

 

• From “Home” tab expand “Surfaces” and select ”Create 
Cropped Surface”  

o The file is required to be saved before using this 
command 

 

 

 

 

 

 

• Click in the “Selection Method” Area of the “Select Crop Area” 
o Draw a rectangle around the area you want to keep 

• Click in the “Create a new Drawing” Area and Select 
a template for the new file 

• Set the layer for which to place the surface on 
o Layer = C-TINN 

• Select “OK” 

 

 

 

 

 

• Go to the new file that was created and save the file 
• Zoom extents and your terrain should show up 




October 6, 2022 

Publish_C3D_Terrain.docx 

    

The following guide is to publish Civil 3D terrain for use in Revit. 

Download the following file from BIM360 

• XXXX000RDETR001.DWG or your clipped terrain (Civil 3D Terrain file)  

 

CIVIL 3D 

PUBLISH TERRAIN 

Open the XXXX000RDETR001.DWG file or the clipped terrain file 

 

Verify that the file has no coordinate 
system set 

 

• From “Toolspace”  on the “Setting” 
tab right click on the name of the 
file 

• Select “Edit Drawing Settings 
• Verify Coordinate System 

o No Datum,No Projection 
• Click OK 

 

 

 

• From “Output” tab select “Publish Surfaces”  

 

 

 

 

• Verify the surface you want is checked 
• Specify and output file location 

o This needs to be on BIM360 
• Click OK 
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